CHAPTER

Configuration Procedures

This chapter tells you how to perform configuration tasks for a LightStream 2020 entefjiviise A

switch, including how to create configuration objects (chassis, cards, and ports), how to provision for
PVCs, and how to configurdartial LAN internetworking attributes. It addition, it describes general
database management functions, such as saving and backing up the global database, and updating a
local database.

This chapter contains the step-by-step procedures for performing all configuration tasks. It does not define
any attributes nor recommend attribute settings: that reference material is provided in Configuration
Attributes and Expert Mode. Therefore, you may want to refer to Configuration Attributes and Expert
Mode while you are using this chapter to configure a switch. Once you are familiar with using the
configuratoryou will probably only use Configuration Attributes and Expert Mode to perform

configuration tasks.

Preparing to Configure a Network

To create a new configuration, you need information on each LightStream switch. If the switch is
already installed in the network, then you can use the configwa#gify function to obtain default
settings for many switch attributes.

If the switch isn't installed, then you need to consider:
® Hardware configuration:
— Determine how many NPs are in the chassis.
— Determine which NPs, if any, require NP IP addresses as well as the NP IP mask?

— Obtain the primary Ethernet IP address, secondary IP address (if one is needed), subnet mask,
and default router address (if one exists).

— Determine the number of line cards of each type (LSC, MSC, PLC, CLC).

— Determine whether the line cards are to be configured as edge or trunk interfaces.
— Determine which chassis slot is each line card in.

— Determine how many ports of each type will be configured on each line card.

® Determine the names you will assign to the nodes, cards, and ports in your LightStream network.
(The configurator will create default names for cards and ports, but you can change them if you
want to.)

® Obtain the chassis ID number for each node. (The chassis ID is stored in EEPROM on the
midplane; use the CLI commastow chassigo display it.)
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® Determine how many trunk ports will connect this LightStream switch to others in the network?
What will be the bit-rate on each trunk?

® Determine how many edge ports will connect this LightStream switch to devices outside the
LightStream network? What will be the bit-rate on each port?

® Familiarize yourself with the configuration of edge devices that will connect to the LightStream
network. For example, you should know

— What types of interfaces are present (frame relay, frame forwarding, ATM UNI, FDDI or
Ethernet)?

— What is the destination and what are the bandwidth requirements for each permanent virtual
circuit?

— Which local management interface (LMI) is used?
— Clocking: what device is providing it, what is the speed?

® Make a list of attributes and values for each chassis, card, and port. See Configuration Attributes
to determine which attributes apply to the interfaces you'll be configuring.

® If your LightStream network is configured with bridging interfaces (FDDI or Ethernet), then you
should know

— Are the default values for the spanning tree bridge attributes acceptable for your application?
— Do you want to specify any custom filters for those ports?

— Do you need to specify any static routes for devices on the attached LANS?

— Do you want to create any workgroups for those ports?

® For each virtual circuit, you will be required to specify the node, card, and port at each end and
the required bandwidth. As you configure the virtual circuits, you might find it helpful to create
a form like the one shown below to keep track of them.

Node Interface #  DLCI/VCI#  Connectsto Node Interface #  DLC/VCI

LightStream1l 2.0 16 LightStream2 9.0 500
LightStream1 2.0 17 LightStream2 9.1 501
LightStreaml 2.0 18 LightStream2 9.1 502
LightStreaml 3.2 40 LightStream2 2.1 600
LightStream1l 4.2 50 LightStream2 3.1 660

Now you're ready to use the configurator to create and load a configuration database, as described
in the sections that follow.

Starting the Configurator

There are actually three separate configuration programs available from theéedpBadt dialog
box:

® Node Configure (also known as cfg), which you use to configure chassis, cards, ports,
internetworking (such as bridging and filters) and SNMP trap attributes

® PVC Configure (also known as pvc), which you use to configure permanent virtual circuit (PVC)
attributes
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® VLI Configure (also known as vli), which you use to configure virtual LAN internetworking
(VLI) attributes

All of the configuration programs read from and write to the same database. Because of a locking
mechanism, only one configurator can write to the database at a time.

You can start and run the configurator under HP OpenView or without it. The following sections
describe both procedures.

Starting Under HP OpenView

In general, you start each configurator in the same Wag/ procedures below use Node Configure
as an example. Any differences are noted.

To start the configurators, use the following procedure.

Step 1 In the OpenView Root dialog box, shown below, double click on the IP Internet icon and
an IP Internet map is displayed OpenView Root dialog bo

Step 2 From the IP Internet map, shown below, you can double click on the desired LightStream
switch icon. (Click on one switch icon to start the Node or VLI configurator and two switch
icons to start the PVC configurator.) The name of the selected node/s are displayed in the
Name field of the first dialog box displayed.

Note You can also skip to Step 3 and not select any icons.

Step 3 Pull down the LightStream menu on the menu bar, and clidkoole Configure PVC
Configure, orVLI Configure . (If you didnt select any icons on the IP Internet map, then the
Name field is left blank on the first screen of the configuyator

Step 4 Select the database access mode on the pop-up dialog box that is displayed. If you select
read/write, then the database is locked to other users and you can make changes to the
database file. If you select read only, then the file isn't locked and you can only examine
the settings in the file. If the configurator reports that someone else is using the database,
see the section “Overriding a Configurator Lock” before proceeding.

Note The configurator automatically opens the default database file (defined by the
LSC_DATABASE variable that is set during installation, as specified by the procedures in the
LightSteam 2020 Installation and Troubleshooting Manual

Starting Without HP OpenView

To start the configurators without HP Openview, use the following procedure. SéghtiStream
2020 Installation Manualor information on the software environment required for the Sun
workstation.

Step1 From the system prompt, typég, pvc, or Vii.
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Step 2 Select the database access mode on the pop-up dialog box that is displayed. If you select
read/write, then the database is locked to other users and you can make changes to the
database file. If you select read only, then the file isn’t locked and you can only examine
the settings in the file. If the configurator reports that someone else is using the database,
“Overriding a Configurator Lock” before proceeding.

Note The configurator automatically opens the default database file (defined by the
LSC_DATABASE variable that is set during installation, as specified by the procedures in the
LightStream 2020 Installation and Troubleshooting Majudbu can open a ddrent file using
the procedure in the section “Making a Backup Configuration File Operational.”

General Configuration Procedures

This section provides a summary of how to perform functions that are frequently used during
configuration with the graphical user interface provided by the configurator.
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Note The configurator uses standard Motif conventions for the graphical interface. See your Motif
documentation for more detailed information. The following table is a summary of frequently used
procedures.

Action

Procedure

Store changes to dialog box

Click on K button at the bottom of the dialog box.

Discard changes to dialog box

Click on thancel button at the bottom of the dialog box.

Return to the previous dialog box

Click on tBK button (any changes are stored).

Click on theCancelbutton (any changes are ignored).

Save changes to global database

Pull down the File menu on the Node Configurator dialog box, and select

Save Changes are written to the global database immediately and sent to the
local database at the time specified by the Update Time attributes.

Enter information in a field box

Click inside the box and type the information.

Edit information in a field box

Use the left and right arrows on the right keypad to move around the field

box. Double click on an entry to select it or depress the left mouse button and,
keeping it down, drag it over the characters you want to select. Ufattie
Space]key to delete selected items or one character at a time.

Select a radio button attribute

Click on one of two (or more) radio buttons to select among mutually

exclusive settings (e.g., enable/disable).

Select a check button attribute

Click on a check button to select that attribute value. (You can click on more

than one check button: check buttons are used for values that aren’'t mutually
exclusive.)

Select from an Option button list

1

Click on the arrow beside the option button to display all available
selections.

Scroll through the list by clicking repeatedly on either the up or down
arrow, or by clicking on the scroll bar and sliding it in the desired
direction.

Click on the desired setting; the list disappears and the selected value is
displayed in the option button.

Select from a list box

To select one entry, click once the desired entry.

To select multiple contiguous entries, click on the first entry, depress the
mouse button and, keeping it down, drag over the entries you want to
select. (In some cases, the configurator dossipport multiple selections

in a list. These are noted where appropriate.)

To select multiple non-contiguous entries, click on the first entry, depress
the[Control] key and click on the other desired entries. (In some cases,
the configurator doesn’t support multiple selections in a list. These are
noted where appropriate.)

Deselecting from a list box

Hold th€ontrol] key down and click the mouse button.

Add to a list box

Enter new information in field boxes or by selecting a radio or check
buttons.

Click on theAdd button and the entry is added to the list.

Delete an entry from a list box

Click on the entry to be deleted.

Click on theDeletebutton and the entry is immediately removed from the
list.
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Action Procedure

Edit an entry in a list box 1 Click on the entry to be edited.

2 Enter changes and click on t&dit button and the list is updated with the
new attributes.

Once you start the configurators, you can make entries or changes in the global configuration
database. The information is not written to the global database until you perform the save operation.
The information from the global database is not sent to a switch until you specify an update time.

Creating a Chassis

This section tells you how to create and configure a LightStream chassis object, starting at the Node
Configurator dialog box. Use the Node Configure tool (cfg) to create a chassis object.

Note In order for the configurator to be able to access a LightStream node throymlr iietwork
administrator must establish and maintain the /etc/hosts file on the Sun workstation running the
configurators. This file correlates the LightStream node name with an IP address, and is needed for
communication between the NMS and the switches LIgiteStream 2020 Administration Guide
describes how to create the /etc/hosts file.

You can create a configuration file for a node before or after it is installed. In either case, the name
given to the chassis during installation should be the same name used during configuration, and the
same name that is entered in the /etc/hosts file. (A chassis can be configured using the IP address as
a name if the /etc/hosts file or name server is not available.)

Note This section does not recommend settings nor describe the various attributes that you can
configure using this procedure. See Configuration Attributes, Expert Mode, or the online help for
that type of information.

In the Node Configurator dialog box, the Chassis Name list box displays a list of all LightStream
chassis that currently exist in the global database file. This does not mean that the chassis have been
installed; it simply means that someone has used the configurator to create a database entry for the
chassis in the global database file.

Note TheSNMP button is not currently available for use; therefore, it is always grayed-out on the
screen.

Note If you started the configurator from the IP Internet map with a chassis selected, then the name
of that chassis is displayed in the Name field.
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Step 1

Step 2

Step 3
Step 4
Step 5

Step 6
Step 7

Step 8

Step 9

Step 10

If you are adding a new chassis, click in Memefield box above the list and type in a
name. The name should be unique and have no more than 32 charactetsisg®amame
that begins with a number or includes quotation marks or other special characters.)

If the chassis has not been installed yet, click irGhassis ID  field box and type in a
unigue ID number You can use a temporary numbe(Once the chassis is installed, you
can use the verify function to get the actual ID number.)

Click on theAdd push button and the new chassis name is added to the list.
Click on the entry in the Chassis Name list to select the chassis you are going to configure.

If you are configuring a chassis that has already been installed, then you can use the verify
function to retrieve the configuration attributes that were entered during installation (or set
to default values by the software). This saves you from having to re-enter that information.
TheLightStream 2020 Installation and Troubleshooting Manneludes a procedure for
setting basic configuration attributes during installation.

Click on theChassisbutton to reach the Chassis Configuration dialog box.

The dialog box provides field boxes for the primary and secondary IP addresses, IP subnet
mask, NP (Ethernet) IP address, NP IP subnet mask, and default router address attributes.
At a minimum, youmustset a primary IP address and subnet mask. Set any other address
or mask attributes as required.

The dialog box also contains a number of optional attributes including system contact and
the location of system. Enter these as desired.

You can also set SNMP agent attributes in this dialog box: you can set the trap filter level
or enable/disable the trap log. Enter these as desired.

To store the changes you have made in this dialog box, click Gthetton. This returns you
the Node Configurator dialog box.

You have now created and configured a chassis object; you can go on to configure card objects, as
described in the procedure that followsuYcan also delete, copy or rename a chassis as described
in the following sections.

Deleting a Chassis

Delete a chassis using the following procedure.

Step 1
Step 2
Step 3

Click on the appropriate entry in the Chassis Name list.
Click on theDeletebutton.

A pop-up dialog box is displayed that asks if you want to delete the chassis. Click on the
OK button to delete the chassis. The record is deleted and the entry is removed from the Chassis
Name list. (Click on th€ancelbutton if you dort want to delete the chassis.)

Note You can'tdelete a chassis that has been configured with any PYCmét delete the PVCs and
update the switches before you can delete the chassis.

Copying a Chassis

Copy a chassis using the following procedure.

Step 1

Click on the appropriate entry in the Chassis Name list.
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Step 2 Click on theCopy button.

Step 3 A pop-up dialog box is displayed. Enter a new chassis name and chassis ID in the field
boxes provided.

Step 4 Click on theOK button to copy the chassis. All chassis, card, port and bridging attributes are
copied to the new chassis and the entry is added to the Chassis Name list. (Clickamtéthe
button if you dort want to copy the chassis.)

Note The PVC and VLI attributes for the chassis moécopied.

Step5 Change the IP addresses for the newly created chassis.

Step 6 Rename the cards and ports, if desired. The configutagsntdo this for you.

Renaming a Chassis
Rename a chassis using the following procedure.

Step1 Click on the appropriate entry in the Chassis Name list.
Step 2 Click on theRenamebutton.
Step 3 A pop-up dialog box is displayed. Enter a new chassis name in the field box provided.

Step 4 Click on theOK button to rename the chassis. The new chassis name is added to the Chassis Name
list and the previous one is removed. (Click orGhacelbutton if you dort'want to rename the
chassis.)

Note When you rename a chassis, the PVC and VLI attributes associated with the chassis are
retained. Youwon't have to re-enter them.

Creating Cards

This procedure explains how to create and configure database objects for the following kinds of
LightStream cards:

® Network processors (NPs)

® |ow-speed line cards (LSCs)

® Medium-speed line cards (MSCs)

® Packet line cards (PLCs)

® Cellline cards (CLCs)

(Switch cards have no configurable attributes, and thus are not offered as card type options.)

Before executing this procedure, you must create a chassis object. You start out in the Node
Configurator dialog box, where the last procedure, “Creating a Chassis,” ends.

Before you configure any cards, you need to know what cards are installed, their slot numbers and
special (non-default) configuration attributes in order to create the configuration file. If the switch has
already been installed, then you can usé/rdy button on the Node Configurator dialog box to
retrieve card configuration information from the switch. The information was entered during
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installation or set to default values by the software.digbtStream 2020 Installation and
Troubleshooting Manuahcludes a procedure for setting basic configuration attributes during
installation.

Step 1 Inthe Node Configurator dialog box, click on the chassis you wish to configure cards for and then
click on theCards push button. The Cards Configuration dialog box (shown below) appears.
The box shows the slot numbers in the LightStream chassis.

Note The NP card normally occupies slot 1; slot 2 holds either backup NP or a line card. Slots 3
through 10 are for line cards only. Slots A and B are designated for switch cards.

Step 2 Click on the push button below the number of the slot that you want to configure. This
button is either labeled Emptyr, if it has been previously configured, it is labeled with an
appropriate abbreviation for the card type. Card configuration attributes are now displayed
across the top of the dialog box.

Step 3 To select a card type, pull down thgoe button and click on the desired card type. The list
closes and the selected type is displayed iyipe option button.

Step 4 To change the administrative status of the card, click on the appropriate radio button. The
default card status is up. Because you can temporarily change the status from the CLI, it’
usually best to leave the status set to up in the configuration.

Step5 You can enter a name for the card by clicking inNlenefield and then typing a name.
(Naming a card is optional. Choose a name with no more than 20 characters, tanmskdon’
name that begins with a number or includes quotation marks.) The configurator provides a default
name, which uses the switch name as a base, if youethber one.

Caution If you are an expert usethen continue to Step 6. See Expert Mode if you are going
to change these values. Otherwise, you can skip to Step 7.

Step 6 To change the maximum number of virtual circuits allowed on the card, click Brpleet
radio button. A default value is provided for this attribute, and in most cases it is not
necessary nor recommended to adjustit. See Expert Mode for more information on this
attribute if you decide to change it.

Step 7 Click on theAdd push button and the push button below the slot number is filled in with an
abbreviation for the card type that you configured, and push buttons (labeled with question marks)
appear in the slot for the number of ports available for that type of line card.

You have now created and configured a card objecatc#n now delete, move, swap, or copy a card.
These procedures are described belu can also go on to create ports on the cards that you have
configured, as described in the procedure that follows.

Deleting a Card

To delete a card and its associated ports:
Step1 Click on the push button below the number of the card you want to delete.

Step 2 Click on theDeletebutton. The card name is removed from the button, it is labeled ,EEmgty
any port icons are removed.
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Note If any PVCs are configured for the card, then they must be deleted and the switches must be
updated before you can delete the card.

Moving a Card to Another Slot
To move a card and its associated ports from one slot to another:

Step1 Click on the push button below the number of the card you want to move.

Step 2 Click on theMove button and the dialog box displays the Selected Destination Slot as shown
below

Note If any PVCs are configured for the card, then they must be deleted and the switches must be
updated before you can move the card.

Step 3 Click on the radio button labeled with the destination slot number and the dialog box is updated
to show the card in its new slot and the old slot is labeled Empty

Step 4 Rename the card and its ports, if desired. The configutagsn'tdo this for you.

Swapping Cards Between Slots
To swap two cards and their associated ports between slots:

Step 1 Click on the push button below the number of one of the cards you want to exchange.

Step 2 Click on theSwapbutton and the dialog box displays the Selected Destination Slot.

Note If any PVCs are configured for the card, then they must be deleted and the switches must be
updated before you can swap the card.

Step 3 Click on the radio button labeled with the destination slot number and the dialog box is
updated to show the cards in their new slots.

Step 4 Rename the card and its ports, if desired. The configutagsn'tdo this for you.

Copying a Card to Another Slot

To copy a card and its associated ports to a slot:
Step 1 Click on the push button below the number of the card you want copy.

Step 2 Click on theCopy button and the dialog box displays the Selected Destination Slot.

Note If any PVCs are configured for the card, then they must be deleted and the switches must be
updated before you can copy the card.
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Step 3 Click on the radio button labeled with the destination slot number and the dialog box is
updated to show the same type of card and ports in the new slot.

Note All port attributes are also copied to the new slot.

Step 4 Rename the card and its ports, if desired. The configutagsn'tdo this for you.

Creating Ports

This section explains how to create and configure ports with the LightStream configurator. A port
type is determined by the configuration settings and the line card module (line card and access card
combination). © configure a port, first you select a card type on the Cards Configuration Manager
This gives you access to individual port attributes.

The configurator card types don't correspond directly to line module names; therefore, Table 3-1
cross-references the configurator card and port types with possible line modules for edge ports, and
Table3-2 cross-references the configurator card and port types with possible line modules for trunk

ports.

Table 3-1 Configuring Edge Ports

If you want to configure this type of And you have this type of line You select this type of card in
port module the configurator

Frame Relay/Frame Forwarding LSC with LSAC LS-Edge

ATM UNI over T3

ATM UNI over E3

ATM UNI over OC3-C

FDDI LAN
Ethernet LAN

Clear Channel

MSC with T3 MSAC
CLC with 4 port T3AC
CLC with 8 port T3AC
MSC with E3 MSAC
CLC with 4 port E3AC
CLC with 8 port E3AC
CLC with OC3AC SM
CLC with OC3AC MM
PLC with FAC

PLC with EAC
PLC with FEAC

PLC with CEMAC

T3-Edge (2 port)
T3-Edge (4 port)
T3-Edge (8 port)
E3-Edge (2 port)
E3-Edge (4 port)
E3-Edge (8 port)
OC3-Eddé port/2 port??)
OC3-Edgél port/2 port??)
FDDI
Ethernet
Ethernet

[Cemac??]
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Table 3-2 Configuring Trunk Ports

If you want to configure this And you have this type of line You select this type of card in

type of port module the configurator

T1 Trunk LSC with LSAC LS-Trunk

T3 Trunk MSC with T3 MSAC T3-Trunk (2 port)
CLC with 4 port T3AC T3-Trunk (4 port)
CLC with 8 port T3AG T3-Trunk (4 port)

E3 Trunk MSC with E3 MSAC E3-Trunk (2 port)
CLC with 4 port E3AC E3-Trunk (4 port)
CLC with 8 port E3AG E3-Trunk (4 port)

OC3 Trunk CLC with 1 port OC3AC SM OCS3-Truifk port??)
CLC with 2 port OC3AC SMI OC3-Trunk(2 port??)
CLC with 1 port OC3AC MM OCS3-Trunkl port??)
CLC with 2 port OC3AC MM OC3-Trunk(2 port??)

1. A maximum of four ports can be used when the module is configured as a trunk.
2. Only one port can be used when the module is configured as a trunk.

Before creating a port you must create at least one chassis object, and at least one card object. The
card must be the type that is appropriate for the port you want to create, as indicated in the list above.
(For example, if you want to create a frame relay port, you have to select LS-Edge as the card type.)
This procedure assumes you are starting out in the Cards Configuration dialog box, where the last
procedure, “Creating Cards,” ends.

If you are configuring the switch before it has been installed, then you need to know the types of
ports for each card and non-default configuration attributes in order to create the configuration file.
If the switch has already been installed, then you can us&thg button on the configurator dialog

box to retrieve any card and port configuration information from the switch that was entered during
installation and default values that were set by software.

Several conventions used by the configurator are true regardless of the type of port that you're
configuring. These are

® Port number is assigned by the configurator based on the positiorPafrthmish button on the
Cards Configuration dialog box. Ports are assigned numbers, starting at zero, from top to bottom
of the dialog box.

® The configurator creates a default name for each port, which is a concatenation of the chassis
name, slot number and port numbesr example, in chassis named boston, the name of the first
port in the third slot would be: boston.3.0. You can give the port another name if you wish.

This procedure describes how to create trunk and edge ports. The general procedure is the same,
regardless of the interface type, only the attributes vary.

The procedure begins in the Cards Configuration dialog box, configured with many of the card types
described in this section.

Note You should configure port 0 on all cards, even if it is not going to be used. This is because
card type is derived from the setting for lowest configured port. Configuring an unused port does not
affect system operation.
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Step 1 Inthe Cards Configuration dialog box, click on a port button that is labeled with a question
mark and a port configuration dialog box appears. This dialog box displays the attributes
appropriate for the type of port that you’re configuring. It also provides default settings for
all attributes.

Note The dialog boxes for each type of port are shown at the end of this procedure.

Step 2 You can use the default name or enter a name for the port, if you wish. (Naming ports is
optional. Choose a name with no more than 20 characters, andiswa’ name that begins
with a number or includes quotation marks.)

Step 3 Examine the other default values and reset any that require adjustment. Then click on the
OK button at the bottom of the dialog box and you are returned to the Cards Configuration dialog
box. If you need information on attributes, click onktegp button on the dialog box or refer to
Configuration Attributes of this book.

You have now finished configuring the physical-level components for your switch: chassis, cards,
and ports. ¥u may now go on to configure network-level attributes (such as bridging and filtering)
and internetwork-level attributes (such as PVC and VLI) as described later in this chapter.

The following subsections show all of the trunk and edge port configuration dialog boxes.

Changing Port Types

With the exception of the LSC edge ports, to change port types you have to delete the card that the
port is on, create the desired card type, and then configure the ports. For instance, to change an E3
edge port to a E3 trunk port you must

® delete PVCs associated with the port and update the switches

® delete the E3 edge card

® create the E3 trunk card

® configure the E3 trunk ports

When changing between a frame relay and frame forwarding port on an LSC edge card, you must
® delete PVCs associated with the port and update the switches

® click on the appropriate radio button at the top of the Frame Relay Port Configuration or Frame
Forwarding Port Configuration dialog box

® configure the ports

Edge Port Dialog Boxes

The following subsections describe the edge port dialog boxes.

LS-Edge Port-Frame Relay
At the top left of the dialog box, there are two radio buttons used to choose between frame relay and
frame forwarding. Frame relay is the default setting. If you want to configure a frame forwarding
port, then click on that radio button and the dialog box is changed to show frame forwarding
attributes.
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Configuring Bridging Attributes

If you have configured any FDDI or Ethernet ports in your network, then you can configure
bridge-level and port-level spanning tree bridge attributes, custom filters for ports, and static routes
for the bridge. The following sections describe each of these procedures.

Spanning Tree Bridge

Custom Filters

Defining a Filter

Use the following procedure to change spanning tree bridge attributes.
Step1 Click on theProtocolsbutton on the Node Configurator dialog box.
Step 2 Click on theSpanning Treebutton.

Step 3 The Spanning fBe Parameters box defines chassis-level bridging attribatelsafige an
attribute, click in the field box and type in a new value.

Step 4 The Interface list displays all configured bridge ports on the chassis with their default settings. If you
want to change any assignments, click on a port to select it, and then tyfoirt fAgority or
Path Costfield boxes to set those values for thet.pdu can also enable or disable spanning
tree bridging on a pgort basis by clicking on tH&TB Enablecheckbutton.

Step 5 Click on theEdit button to store the changes. The parameters in the list box are updated to reflect
the newly entered values.

Step 6 Repeat Step 4 and Step 5 for any other ports with default values that you wish to change.

Step 7  Store the changes you have made to this dialog box by clicking Ofthatton. (You can also
click on theCancelbutton to discard these changes.)

You can use the custom filters capability to set up multipkp@etfilters on a chassis. Based on the
filters applied to a port, the bridge will drop or forward incoming frames. This feature is primarily
used for security. Refer to Configuration Attributes for examples of filters that you might create.

You create custom filters on a frassis basis. Creating a custom filter consists of defining the filter
and then assigning the filter to a port or ports. You may assign multiple filters to one port and you
may assign the same filter to multiple ports.

Use the following procedures to define filters, change or delete filters, and assign custom filters to a
port/s. Before you can create custom filters, you must configure a chassis and at least one FDDI or
Ethernet card and associated ports.

Step1 Click on theCustom Filters button on the Protocols Configuration dialog box, and the Bridge
Custom Filtering dialog box appears.

Step 2 In the Defining Filters box, click in tHélter ID field box. You can determine whether the ID
in the box has already been used by comparing it to the Filter ID list located above the box. If the
ID has not been used, then skip to step. If the ID has already been used, then type in the next
highest unused ID.

Step 3 Create the filter expression in the Filter Expression field by entering fields, constants, and
operators in the Filter Expression field box in one of the following ways:
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® Click on the appropriatEields or Operators radio button. The field or operator is
immediately added to the Filter Expression field baxefiter a constant, click on the
appropriatd-ields radio button, and type in a value in @enstantfield box. Then, click on
anOperators radio button. The operatdollowed by the constant, is added to the Filter
Expression field box.

® Click in theFilter Expression box and type in the fields, constants and operators.

Note In the Filter Expression field box, you can use \{8aick Spacekey to delete characters, and
the left and right arrows on the right keypad to move through the testtlct something in the Filter
Expression box, you catoubleclick on a constant, field or operator to select it, or you can depress the
first mouse button and, while keeping it depressed, drag it past the characters you want towsetett. Y
then delete the selected characters.

Step 1 To add the filter to the Filter ID list, click on thadd button and the Filter ID list is
updated with the new filtelhe dialog box below shows a switch that has been
configured with a single custom filter: (macProto==6004) Would enter this filter as
follows:

® Click on themacProto radio button. macProto is added to the Filter Expression box.
® Enter6004in the Constant field box.

® Click on the== radio button and ==6004 is added to the Filter Expression box.

® Click on the Add button and the Filter ID list is updated with the new filter

Now you can assign the filter to a port, using the procedure, “Assigning a Filter.” If you are not going
to assign any filters right now, then you can keep the changes you have made in this dialog box by
clicking on theOK button at the bottom of the dialog boxo(lYcan also click on ti@ancelbutton to

discard these additions.)

Editing or Deleting a Filter

After you have defined a filter, you can edit or delete it. To edit or delete a filter, you work in the
Defining Filters box on the left-hand side of the Bridge Custom Filtering dialog box.

Step 1 To edit an existing filterclick on the filter entry in the Filter ID list. The filter is displayed
in the Filter Expression field box at the bottom of the dialog box. Change the expression in
the Filter Expression field box as desired.

Note Once you have selected a filter entry from the Filter ID list, you have to delete the values the
ID and expression boxes if you want to add another filter.

Step 2 Click on theEdit button. The Filter ID list is updated with the changed filter

Note Once you have selected a filter entry from the Filter ID list, you must either click Bdithe
or Deletebutton to deselect it.
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Step 3

Assigning a Filter

To delete an existing filter, click on the filter ID in the Filter ID list and then click on the
Deletebutton. The filter ID is removed from the Filter ID list.

If you want to assign the changed filter to a port, use the following procédsigning a
Filter. If you are not going to assign any filters right nilv&n you can keep the changes you have
made to this dialog box by clicking on & button at the bottom of the dialog boxo(i¥can
also click on th&€€ancelbutton to discard these changes.)

After you have created or modified a filtgou can then assign it to a port or multiple portsagsign
a filter, you work in the Assigning Filters box on the right-hand side of the Bridge Custom Filtering
dialog box.

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

In the list of interfaces at the top of the box, click on the interface for which you want to
assign a filter (Any previously assigned filters are displayed in the List of Filter IDs box.)

If required, change the Default Action of the port from forward to block by clicking on the
Block radio button.

If desired, change the broadcast limit.

At the bottom of the Assigning Filters box, click on the arrow next té&ilter ID option
button to display the list of configured filter IDs.

Click on the appropriate filter ID.

Click on either th&orward orBlock radio button next to the Filter ID field box to select the action
that you want taken if a match is found. If no action is specified, then the opposite of the default action
for the interface is used.

Enter the priority of the filter. (Filters are executed in order of their priority setting; the
lowest numerical value has the highest priority.)

Click on theAdd button located next to the List of Filter IDs to assign the filter to the interface. The
filter is displayed in the list.

Repeat Step 4 through Step 8 for as many filters as you want to assign to the interface.

When you have added all the filters for the port, click ol\phydy button at the bottom of the
Assigning Filters box. This assigns the filter/s to the selected port. Once you have clicked on the
Apply button, the List of Filter IDs is cleared.

Repeat Step 1 through Step 10 to assign one or more filters to other ports.

You have now defined and assigned youpet custom filters. 8u can store the changes you have
made to this dialog box by clicking on tB& button. (\ou can also click on th@ancelbutton to delete

these changes.) Remember that these values are not written to the global database until you use perform
the save operation.

Editing or Removing a Filter from a Port
After you have assigned a filter to a port, you may want to change its Action or its Priority setting,
or remove it from the active filters for the port. To edit or remove a filter from a port, you work in
the Assigning Filters box on the right-hand side of the Bridge Custom Filtering dialog box.

Step 1

Step 2

In the list of interfaces at the top of the box, click on the interface number with the filter
that you want to edit or remove. The list of applied filters is displayed below in the List of
Filter IDs.

In the List of Filter IDs, click on the desired filter.
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Static Routes

Step 3 To edit the filteryou can change the Action or Priority setting and then click oRdhe
button.

Step 4 To delete the filter from list of filters for the port, click on the filter entry in the List of Filter
IDs and then click on thBeletebutton. The filter is removed from the list.

Step 5 To assign the edited filters to the port, click onAlpgly button at the bottom of the box.

You can store the changes you have made to this dialog box by clicking©HK thetton at the
bottom of the dialog box. @d can also click on tHeancelbutton to delete these changes.)

This section describes how to create static entries in the bridge’s filtering database. (This
functionality is specified in IEEE 802.1d-1990.) The filtering database equates a MAC destination
address with a LightStream port that can receive frames with this MAC destination address and a set
of LightStream ports on which the frames should be transmitted. The bridge forwarding process uses
the entries in the filtering database to determine if frames with a given MAC destination address can
be forwarded to a given port or ports. You create static routes on a per-chassis basis.

Use the following procedure to create static entries in the bridge’s filtering database.
Step1 Click on theStatic Routesbutton on the Protocols Configuration dialog box.

Step 2 Enter the MAC address, receive port and transmit port addresses in the field boxes provided
on the dialog box.

Step 3 Click on theAdd button to store the route and the list box is updated with the new static route.

Step 4 To edit an existing route, click on that route in the list box. Change the desired attributes
and click on théodify button. The route is stored and the list box is updated to show your
changes.

Step 5 To delete a route, click on that route in the list box and click ob#hetebutton.

Step 6 Store the changes you have made to this dialog box by clicking @ktheitton. (You can
also click on the&Cancelbutton to delete these changes.)

You have now defined your pport static routes. Remember that these values are not written to the
global database until you use perform the save operation.

Provisioning for PVCS

You must specify the endpoints of a PVC and certain characteristics of the PVC as a part of configuration.
Once you have entered this information, the LightStream switch can set up a PVC between the two endpoints.

Use the following procedure to provision for PVCs between
® two existing frame relay ports

® two existing frame forwarding ports

® two existing ATM UNI ports

The configurator allows you to provision for both ends of the PVC at the same time. You can
establish many PVCs between the same ports, except for frame forwarding ports.

Note To configure a PVC, you must have previously configured the two edge ports that it will
connect.
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Step 1 Start the PVC configuration tool.

Note If you started the configurator from the IP Internet map, with the two chassis selected, then
the names of those chassis are displayed in the Chassis A and Chassis B field boxes.

Step 2 Enter the desired endpoints by selecting the Name, Card and Port for Chassis A and B.

Note You can also use All for card and port settings to verify all PVCs between the chassis. You
can edit and delete PVCs when All has been selected but you can’'t add new ones.

Step 3 Display currently configured PVCs, using one of the following steps:

® To retrieve the settings from the local database stored in run-time memory on the nodes,
click on theVerify button.

® To retrieve the settings from the global database, click oRe¢lael DBbutton. All
PVCs currently configured between the two endpoints in the global database are
displayed.

Step 4 To provision for a new PVC, select the desired Name, Card and Port for Chassis A and B.

Note You must configure attributes for both Chassis A and B. Chassis A attributes are for the VC
from Chassis A to Chassis B. Chassis B attributes are for the VC from Chassis B to Chassis A.

Step 5 Click on theNew button and the configurator supplies the next available DLCI or VCI
number as well as the default values for the circuit. If you choose to manually enter VCI or
DLCI numbers, the configurator checks to ensure that the number you use is unique for the
port.

Note VCls are used for BM UNI PVCs, DLCIs are used for frame relay PVCs, and no identifier

is required for frame forwarding PVCs because there is only a single PVC between frame
forwarding ports. In the rest of the procedure, VCI is used as an example but the same information
applies to DLCIs and frame forwarding PVCs. The VCI field box label changes to DLCI for frame
forwarding PVCs and is removed for frame forwarding PVCs.

Caution If you are an expert usghen continue to Step 6. See Expert Mode if you are going to
change these values. Otherwise, you can skip to Step 7.

Step 6 To change expert mode attributes, pull down the Expert Setting menu and choose to display
expert settings. Default values are provided for these attributes, and in most cases it is not
necessary nor recommended to adjust them.See Expert Mode for more information on these
attributes if you decide to change them.

Step 7 Click onAdd and the Existing PVCs list is updated with the new PVC.
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Step 8 To copy a PVC, if you are creating many PVCs between the same endpoints with the same
attribute values, use the following procedure:

® Configure the PVC that you want to copy by following Step 4 through Step 7.

® Doubleclick on the PVC that you want to cofhis loads its attribute settings into the
field boxes.

® Click on theNew button. (This gives you the next available DLCI/NVCI number
® Click on theAdd button. The Existing PVCs list is updated to show the new PVC.
® Continue clickingNew for as many PVCs as you wish to create.

Step 9 To edit the attributes of an existing PVC, double click on the PVC in the Existing PVCs
box. (You can select multiple PVCs, with the exception of having to double click on the
first entry to load the attribute settings into the field boxes so that you can edit them.) The
existing attribute settings are displayed in the attribute fields. Change the attributes and
click on theEdit button. The Existing PVCs list is updated to display your changes.

Step 10 To delete a PVC, click on the PVC (or PVCs) in the Existing PVCs list and click on the
Deletebutton. This deletes the PVC and removes it from the Existing PVCs box. The
configurator automatically deletes both VCs (one in each direction) that comprise the PVC.

After you have finished provisioning for PVCs, you set the Update attributes for the chassis pair.
Then, in order to write the changes to the global database and enable the local database updates, you
must perform the save operation.

If you don’'t want to save any of the information from this session, then you can click Closee
button; you exit from the configurator without saving any changes.

Configuring VLI Attributes

This section tells you how to configure virtual LAN internetworking (VLI) attributes for bridging ports. Use
the following procedure to configure your workgroups.

Workgroups are created on a network-wide basis. Creating a workgroup consists of defining a
workgroup name and ID and then assigning an interface or interfaces to the workgroup. You may
assign multiple interfaces to one workgroup and you may also assign the same interface to multiple
workgroups.

Note By default, all interfaces belong to the same (Default) workgroup. This enables all interfaces
to initially communicate with one another. Once you assign an interface to a workgroup, that
interface is then removed from the default workgroup.

Use the following procedures to create workgroups, create a list of interfaces to be assigned to a
workgroup, and assign one or more interfaces to a workgroup. Before you can assign interfaces to a
workgroup, you must configure a chassis and at least one FDDI or Ethernet card.

Creating a Workgroup
Step 1 Start the VLI configuration tool.

Step 2 To add a workgroup, click in tidamefield and enter a workgroup name.

Step 3 Click in thelD field and enter an ID for the workgroup.
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Step 4

Step 5

Click on theAdd button, and the workgroup hame and ID is stored and displayed in the
Workgroups list.

To delete a workgroup, click on the appropriate name in thd&dtbups list and then click
on theDeletebutton. The workgroup is deleted and removed from the list.

Note You can delete a workgroup even after it has been assigned to a interface. The configurator
automatically removes the interface assignment/s when a workgroup is deleted.

Step 6

To change the workgroup name or ID, click on the entry in thekvoups list, click in the
appropriate field box and make your change. Then click oBdhebutton. The
Workgroups list is updated to show your change/s.

Now that you have defined your workgroup/s, you can create a list of the interfaces that you
want to include in a workgroup and then assign the interfaces to the workgroup, using the
following procedures.

If you aren’t going to assign any interfaces right now, then you can save your workgroup
definitions by saving and exiting the configurator. If you don’t want to save any of the
information from this session, then you can click onGlesebutton; you exit from the
configurator without saving any changes.

Creating a List of Interfaces

In order to assign interfaces to a workgroup, you must first create a list of interfaces to be assigned.
You create the list by working in the Interface Selection box on the right-hand side of the dialog box.

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

To create a list of interfaces, select the interface by choosing the appropriate Chassis Name,
Card, and Port from the option boxes in the Interface Selection box.

Click on theAdd push button, and the interface is stored and displayed in the Selected Interfaces
list.

Repeat Step 1 and Step 2 for all the interfaces you want to include in the workgroup.

If you want to see what workgroups an interface has already been configudidKamn

the interface in the Selected Interfaces list and click oWehiéy button. The configurator

gets the current configuration from the local switchh-time memory and displays it in the
workgroups summary boxov can then apply the information to the database or discard it. If
you apply it, then it is saved to the configuratéemporary workspace—replacing the values

that were there. If you discard it, then it is not saved and the summary box redisplays the original
values.

To delete an interface from the Selected Interfaces list, click on the interface in the list and
click on theDeletebutton.

If you want to clear the Selected Interfaces list, click orCllear button.

Now that you have defined your workgroup/s and created a list of the interfaces that you want to
include in a workgroup/s, you can assign the interfaces to the workgroup/s, using the following
procedure.
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Assigning Interfaces to a Workgroup

In order to assign interfaces to one or more workgroup, you work in the Workgroups box, the
Interface Selection box, and the workgroup summary box. The workgroup summary box is located
at the bottom of the dialog box. This procedure begins where the previous procedure ends: you have
already created a list of interfaces in the Selected Interfaces list.

Step1 To make assignments to a workgroup, click on the workgroup/s name in the Workgroups
list.

Note If you want to change the Interface Control Mode from the default setting, click on the
Exclude radio button.

Step 2 Click on theAdd button located above the workgroup summary box at the bottom of the dialog box
and every interface in the Selected Interfaces list is associated with the selected workgroup/s. The
workgroup summary box is updated to reflect your assignments.

Step 3 Once you have completed assigning interfaces to a workgroup, you can click rathgutton
to clear the Selected Interfaces list.

Step 4 After you have assigned interfaces, you can determine which interfaces belong to a
certain workgroup by clicking on the workgroup name in treeRroups list and then
clicking on theFind button. The workgroup summary box is changed to show the
interfaces associated with that workgroupu¥tan then add or delete interfaces from
the workgroup. Click on th€lear Find button to restore the workgroup summary box
to its original form.

Step5 Toremove an interface/s from a workgroup, select the desired workgroup/s and interface/s,
and then click on thBeletebutton located above the workgroup summary box at the
bottom of the dialog box. The selected workgroup will be deleted from all interfaces in the
Selected Interfaces list.

Step 6 To change the interface control mode after you have set it, select the desired workgroup/s
and interfaces, change the interface control mode, and click &uihbutton. The
workgroup summary box is updated to reflect your changes.

After you have finished VLI configuration, you set the Update&ttributes for the chassis. Then, in order
to write the changes to the global database and enable the local database updates, you must perform the save
operation.

If you don’t want to save any of the information from this session, then you can click ©losiee
button; you exit from the configurator without saving any changes.

Changing Interface Control Mode

The default interface control mode is Include, which should be the appropriate choice for the
majority of applications. The Exclude mode should be used when you want a port to be able to
communicate with all or almost all workgroups. It has tiiectbf excluding the port only from the
specified workgroups and allowing it to communicate with all of the others. If you want to change
the mode, use the following procedure.

Step1 Select the workgroup/s in the Workgroups list.

Step 2 Select the interface/s in the Selected Interfaces list.
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Step 3 Change the interface control mode by clicking onEkelude (orInclude if changing back
again) radio button.

Step 4 Click on theEdit button and the workgroup summary box is updated with your changes.

Note The include/exclude setting is an interface-level attribute: yotieaiide a interface from some
workgroups and include the same interface in other workgroups.

Database Management Operations

Exiting the Configurator
Use the following procedure to exit from any of the configurators.

Step 1 In the Node Configurator dialog box pull down the File menu and dexéct

Step 2  If you selecExit without saving first (see the following procedure), then the configurator prompts
you to Save, Discard or Cancel.

® Click onSaveto save your changes to the database file specified when you started the
configurator

® Click onDiscard if you want to exit the configurator without saving any changes.

® Click onCancelif you want to continue the configuration session and damit to exit from
the configurator

When the exit is complete, the configurator’s dialog box is closed.

Saving or Aborting Changes
Use the following procedures to save or abort changes made to a configuration database.

Saving Changes
You can save changes periodically during your configuration session as follows:

In the Node Configurator dialog box, shown above, pull down the File menu andSseledny
changes made up to that point are saved to the global database.

Note Once you save changes, yaant revert to the version of the database that existed before the save
was performed.

Aborting Changes

You can abort changes at the database level or at the dialog box level. If you decide that you don’t
want to save the entire configuration file you have created, Ezlecfrom the File menu on the menu

bar on the Node Configurator dialog box. The configurator prompts you to Save, Discard or Cancel. Click
onDiscard if you want to exit the configurator without saving any changes. (If you have periodically saved
your changes as described above, then the database retains any changes made before the last save.)
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You can use th€ancelbutton on any dialog box to delete any changes you just made to that screen.
(You save changes by clicking on & button.)

Updating a Configuration

This section explains how to set the update time attributes for the configurators. Each configurator
requires you to set update time attributes. These attributes determine when the local databases will
be updated and the type of update to be performed. Once you perform the save operation, as
described in the preceding section, the configurator updates the local databases at the specified times.

There is no correlation between update times for therdiit configurators: the same node can have
different update times for the node, PVC and VLI updates.

After a switch has been updated, the new configuration begins to take effect immediately; the new
data is completely distributed within a few minutes. If you reload an operating node, the flow of
traffic may be briefly disrupted. (Only those ports or lines whose attributes are changed by the new
configuration will be affected.) If you're concerned about interrupting traffic, plan to download
configurations at a time when the interruption will have the least impact.

The procedure below assumes the following:
® You have already created a configuration and saved it, as described earlier in this chapter.

® The switch to be updated has been installed with a basic configuration, as described in the
LightStream 2020 Installation and Troubleshooting Manual

® The workstation where the configuration program is running has network access to the switch
that you wish to download. (IP connectivity to, and then indirect connection via any LightStream
node, is sufficient.)

Note If you're updating new configurations that change internodal (e.g., trunk) parameters in an
incompatible way, be sure to update the most distant nodes that have new trunk parameters, first.
(Distant refers to the combined IP and LightStream path from the NMS todberade.) %u will

lose contact with those nodes temporatihtil the intermediate nodes are downloaded with the new
parameters.

Node and VLI Configuration Updates
The Update Time menu and procedure for the Node and VLI configurators are the same.

Step 1 In the first dialog box displayed by the configuration tool, pull down the SendUpdate menu
from the menu bar and seléd¢pdate Time.

Step 2 Select the chassis that you want to update from the list provided by clicking on its name.
The list displays all chassis configured in the global database céydselect multiple
chassis in this list.)

The list displays the timestamp of the currently configured update as well as the status of
the update at the time the dialog was displayed; the status is not updated while the dialog
box is being displayed. Update status can be one of the following:

® Complete: Indicates that update has been successfully completed.
® Failed: Indicates that the attempt to update the node has failed.

® No Entry: Indicates that there is no entry for update time in the global database for that
node.
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Step 3

Step 4

Step 5
Step 6
Step 7

Step 8

® In Progress: Indicates that the configuration agent is in the process of updating the
switch at the time the UpdateTime dialog box is being displayed.

® Scheduled: Indicates that you have scheduled an update for some time in the future and
that the global database entry for that update exists.

® Scheduling: Indicates that you have specified an update for some time in the future but
you have not saved to the global database, so no entry in the global database exists yet.
After you save to the global database, this changes to Scheduled.

® Clearing: Indicates that you have selected to clear the update time entry for the switch
but you have not saved to the global database, so the previous entry still exists in the
database. After you save to the database, this changes to No Entry.

Set the date and time for the update specify an update time in the future, you can enter
the date, day and time in the appropriate field boxes or click dpetie Update
Immediately After Savebutton.

Select the type of update. Accept the default, which is to send only the changed attributes,
or click on theSend all attributesradio button to select a full update.

Click on theEdit button to store these changes so that they can be written to the global database.
Repeat this procedure for each chassis.

To change update time attributes, click on the desired entry in the list, make your changes,
and click on théedit button. The list is updated to show your changes.

Click on theOK button to close the dialog box. After you saved the configuration to the global
database, the configurator updates each local database at the specified time and date.

PVC Configuration Updates

Step 1

Step 2

In the first dialog box displayed by the configuration tool, pull down the SendUpdate menu from the
menu bar and selddpdateTime.

Select the chassis pair that you want to update from the list provided (Chassis A and Chassis B) by
clicking on its name.

Note The list displays the selected time and status of the update.

Step 3

Step 4

Step 5
Step 6
Step 7

Step 8

Set the date and time for the update specify an update time in the future, you can enter
the date, day and time in the appropriate field boxes or click dpetine Update
Immediately After Savebutton.

Select the type of update. Accept the default, which is to send only the changed attributes,
or click on theSend all attributesradio button to select a full update.

Click on theAdd button to store the update time so that it can be written to the global database.
Repeat this procedure for each chassis pair.

To change update time attributes for one, pak on the desired entry in the list, make your
changes, and click on tkglit button. The list is updated to show your changes.

To delete an entry, click on the desired entry in the list, click oGl button, and the
entry is removed from the list.
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Step 9 Click on theOK button to close the dialog box. After you save the configuration to the global
database, the configurator updates the local database on each pair of switches at the specified time
and date.

Common Update Errors
This section describes how to react to three error messages commonly encountered during an update.
These messages are recorded in the configurator’s log files.

Use Table 3-3 to determine the cause of the error, if you get the following error measége:
get lock on chassis chassis name ... gave up.

Note If you get this error message, then you should reschedule the update after the problem has
been corrected.

Table 3-3 Responding to Can’'t Get Lock on Chassis Error Message

Possible Causes Response

The SNMP set community name of Determine the set community name of the NMS and the community name on
the NMS does not match a switch that has read/write permission and the set community name of the
community name on the switch that NMS. Change one of them (or both, if you like) so that they are the same.
has read/write permission.

To determine which community name has read/write permission on the
switch, see Changing the Default SNMP Community Names in the
LightStream 2020 Administration Guide change the name, if desired, see
Procedure to Change the Default SNMP Community Names liightStream
2020 Administration Guide

To determine the set community name on the NMS: If you're running under HP
Open\iew, pull-down the Options menu and select SNMP Configuration. Change
the set community name, according to your HP Osmdocumentation, to

match a community name on the switch that has read/write permission.

If you're running without HP Operi®tv, open the ovsnmp.conf file using a text
editor Change the set community name in the file to match a community name on
the switch that has read/write permission.

The chassis is being updated by ~ Check to determine if the local database file is locked by using theh©ial

another NMS or someone has lockedonfig command. The system reports if the database is locked or unlocked.

the local database file using the CLI(The CLIshowcommand is described kightStream 2020 Command and
Attribute Reference Guide

If the database has been locked through the CLI, you can unlock it using the CLI.
(See How to Change Attribut@Mes in thé.ightStream 2020 Command and
Attribute Reference Guide

If the database has been locked because another NMS is updating the database,
then you should wait until the update has been completed and the lock will be
released.

The switch is down. Use thing command to determine if the switch is down. Py
command is described in Using the ping Command iigigtStream 2020
Administration Guide
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Use Table 3-4 to determine the cause of the error if you get the following error mé&isiie:
timed out - chassis chassis name s not responding.

Note If you get this error message, then you should reschedule the update after the problem has
been corrected.

Table 3-4 Responding to SNMP Timed Out Error Message

Possible Causes Response

The default values for the timeout forlf you're running under HP OpenView, pull-down the Options menu and
SNMP set commands is set too low select SNMP Configuration. Change the timeout value to 7 seconds and the
on the NMS. retry value to 5.

If you're running without HP OpenView, open the ovsnmp.conf file using a
text editor. Change the timeout value to 7 seconds and the retry value to 5.
(These are the default settings that have been provided at installation.)

The chassis went down during the Use theping command to determine if the switch is down. Ppiregy
update. command is described in Using the ping Command ihidgif@Stream 2020
Administration Guide

Use Table3-5 to determine the cause of the grifoyou get the following error messagw:such
item <MIB object name>.

Note If you get this error message, then you should reschedule the update after the problem has
been corrected.

Table 3-5 Responding to No Such Item Error Message

Possible Causes Response

There is no software process In many cases, the named object is cardName.card#, which indicates that card

currently registered for the object  being loaded is down. To get the card’s status, use thel@ card status

named in the error message. command described in Displaying Configuration Parameters in the
LightStream 2020 Command and Attribute Reference Guide

Reading Log Files
The configurator creates a log file for each update of each switch. The following procedures describe
how to use the configurator or UNIX utilities to display the contents of a log file.

Using the Configurator
Use the following procedure to read log files from the Node, PVC, and VLI configurators.

Step 1 Display the update time dialog box for the configurator

Step 2 Click on the chassis or chassis pair in the list box.

Step 3 Click on theShow Logbutton.

Step 4 Click on the desired log file from the list displayed by the pop-up dialog box.
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Step 5 Click on theOK button in the pop-up dialog box and the contents of the file are
displayed.

Step 6 To display a dfierent log file, click on th&nother Log  button and repeat Step 3 and
Step 4. (If there are no other log files for the selected chassis or chasstisgrathe
button is grayed-out.)

Step 7 To delete the log file, click on tiRemove Logbutton. The file is deleted immediately

Note You can delete a log file in read/write mode or read only mode.

Step 8 To return to the dialog box, click on tRi#osebutton.

Using UNIX Utilities

You can use UNIX utilities such asat or more to display the contents of a log file. See the
appropriate UNIX documentation for information on using those utilities.

If you are running under HP OpenView, log files reside in the following path: /usr/OV/log. If you
are running without HP OpenView, then the log files reside in /usr/LightStream-2.0/log.

In addition, the configurator creates a subdirectory for each switch. The subdirectory is named with
the switch’s Chassis ID: log files for a switch with the chassis ID 5144, that was created by a
configurator running without HP OpenView, would be stored in /usr/LightStream-2.0/log/5144.

Log file names include the date, time, and configurator as shown in the following examples:
® Aug-25-94_14:15.cfg is a log file for the Node configurator

® Aug-25-94_14:15.pvc is a log file for the PVC configurator

® Aug-25-94_14:15.vli is a log file for the VLI configurator

You can use a UNIX utility such as to delete a log file.

Backing Up Your Database

We recommend that you keep, at a minimum, one up-to-date backup of your global configuration
database on the NMS, disk space permittiray ¥hould also make a copy of the global database on

a tape or disk. See the documentation that came with your management station for information on
how to copy to and restore from your backup media.

Note If you need to restore a local database, simply update the switch from the global database.

The procedures in this section tell you how to save and reload backup configurations, and how to
copy your database to another site.

Saving a Backup Configuration Database
Follow the steps below to save a backup copy of your configuration database.
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Note Backup files are intended for use as an archival mechanism. The backup files can be read and
even changed using the configuration tools but cannot be used to update a switch.

Step 1 Pull down the File menu on the menu bar of the Node Configurator dialog box, ariaatesis

Step 2 Click in the Directories list to select a directory path. The selected path is shown in the Save File
field box.

Step 3 Click in theSave Filefield box, and enter a name for your backup copy that is easy to
distinguish from your operational copy

Step 4 Click on theOK button and the copy is written to the hard disk with the new name.

Note Note: Actually two files are created: one with a .pag extension and one with a .dir extension.
The .pag version is the only one that appears in the Files list, but both are used by the configurator.

Step 5 To verify that the copy was created, you can pull down the File menu again, ardizefedthe
pop-up menu that appears lists all database files that exist on the hard disk. Check that the backup
file you just created is listed there, and click orGhacelbutton.

Opening a Database File
Follow the steps below to explicitly open a configuration fiteu ¥hay use this procedure to open a
database file that isn't specified by the LSC_DATABASE variable, for instance, a backup file.

Step 1 Pull down the File menu on the menu bar of the Node Configurator dialog box, and select
Open..

Step 2 In the Directories list, select the correct directory by double clicking on the correct path.
Step 3 In the File list, double click on nhame of the backup copy you wish to open.
Step 4 Click on theOK button.

Step5 Select the database access mode on the pop-up dialog box that is displayed. If you select
read/write, then the database is locked to other users and you can make changes to the
database file. If you select read only, then the file isn’'t locked and you can only examine
the settings in the file. If the configurator reports that someone else is using the database,
see the section “Overriding a Configurator Lock” before proceeding.

Changes you make during the configuration session are now saved to the file you have specified.

You can use thEilter button in the pop-up menu to search a directory for files with common strings

in their names. For example, in the pop-up menu shown above, as a default the Filter field specifies
a search for any files ending in .pag and displays them. You can clickRiiténefield, change the

search string, and then click on Fiker button to display the files.

Making a Backup Configuration File Operational
If you wish to use your backup files as your operational database files, then yowc@ofdtbe
following:
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® Change the backup file names to the default database names, configure.netdb.pag and
configure.netdb.dir, using UNIX commands sucle@er mv. (First, remove the existing default
database files.)

® Enter the configurator and open the backup file and the Saeet/s from the File menu and
specify the default database file name, configure.netdb.pag. This writes the contents of your backup file
into the default file.

® Setthe LSC_DATABASE environmental variable to define your backup file as the default
database.

Copying Backup Database to Diskette
Use the following procedure to archive a backup copy of the database to a diskette.

Step 1
Step 2

Step 3

Step 4

Create your backup files.

To compress the files, at the system prompt, enter:

compress <filename>.*

Insert a diskette into the disk drive attached to your Sun workstation and format the diskette
by entering:

fdformat /dev/rfd0

The system responds:

Please hit return to start formatting f loppy.  [Return]

You may need more than one diskette, depending on the size of the database.

To transfer the files to the floppy, once the floppy has been formatted, enter:

bar cvf /dev/rfd0 <filename>*

The system responds:

a filename .dir.Z 1 blocks 1
a filename .lock.Z 1 blocks 1
a filename .pag.Z 87 blocks 1

Note The size of your files in blocks may vary from that shown here.

If prompted for another diskette, remove the diskette from the drive and insert another one. If more
than one diskette is required, you should number them in the order that they were made. When the
copy is finished, remove the last diskette from the drive, number it, and store it in a safe place.

Step 5

Step 6

To recover the files from the floppy, first change to the desired directory, by entering:

cd <directory name>

Then, enter:
bar xvf /dev/rfd0

The system responds:
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x filename .dir.Z, 253 bytes, 1 tapr blocks 1
x filename .lock.Z, 53 bytes, 1 tape blocks 1
x filename .pag.Z, 44188 bytes, 87 tape blocks 1

Note The size of your files in blocks may vary from that shown here.

If prompted for the next diskette, remove the diskette from the drive and insert the next one. When
you have finished retrieving the file from diskette, remove the last diskette from the drive.

Step 7 To uncompress the files, enter:

uncompress <filename>*.Z

Copying a Database to Another Site
If you want the added backup protection, you can copy the backup database to another site. The
configurator does not provide this function, so you can usgptheommand at the system prompt to
transfer the .pag and .dir backup files to another site.

Verifying a Database
Each configurator provides a verify function. Use the verify function to

® retrieve configuration values entered at installation and default values provided by software
when you're configuring a new switch that has already been installed on the network

® retrieve the configuration values that are currently running in a particular LightStream switch if
you want to get values that have been changed through the CLI and store them in your global
database

As shown in Figure 3-1, the verify operation retrieves the information from the NP’s run-time
memory. At that point, you can either save the information from the switch or discard it.

Figure 3-1 Operation of the verify function

Sun Workstation LightStream Switch

Verify Local Database in
Run-Time Memory

H3524

Verifying Node Attributes
Use the following procedures to perform the verify function.

Step 1 Click on the name of the chassis that you want to verify in the Name list. (The list displays
any chassis defined in your global database file.)
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Step 2 Click on theVerify button on the Node Configurator dialog box. All of the configuration settings
are retrieved from the switetun-time memonfhe dialog box is updated to contain a summary
of differences found between the global database and the switch.

Step 3 Check the list to see the differences between the two databases.

Caution If a card is down, due to a fault or an administrative action, then only the card type, slot
number and status are available to the verify function. If you save the results of the verify when a
card is down, it erases all of the other card and port attribute values in the confiyteatporary
workspace and you will have to reconfigure them. If you accidentally save the results of the verify
then you can either exit from the configurator without saving or you can wait until the card comes
up and perform another verify. (If you exit without saving, you lose any other changes you have
made during the editing session.)

Step 4 To store the settings from the local database in the configurator’'s temporary workspace,
click on theApply button. (This replaces any settings that were there.)

Step 5 If you don’t want to incorporate the local settings, then click orbikeard button.

Step 6 If you want to replace the local settings with the global settings, then you must update the local
database.

Verifying PVC Attributes

You can retrieve configuration information for PVCs between switches, cards or ports using the
following procedure.

Step 1 Start PVC Configure.

Step 2 Select the names of the chassis you want to verify in the Node A and Node B Name field
boxes. ¥u can refine your search further by selecting a card and/or port under the Node A
and Node B field boxes.

Step 3 To retrieve configuration values from the switch, click orvidfy button. The configurator
gets the current configuration from the local swichih-time memonyit displays matching
PVCs in the Existing PVCs list. Any tlifences between the global and local database are
displayed in a pop-up dialog box.

Caution If a card or port is down, due to a fault or an administrative action, then no PVCs are
displayed. If you save the results of the verify when a card or port is down, it erases all of the PVC
attribute values for the selected endpoints in the global database and you either have to reconfigure
them or wait until the card/port comes up and perform another verify.

Step 4 To store the values from the local database in the global database, diakeofrom the
pop-up menu. Unlike the Node and VLI configurators, the PVC verify function writes to the
global database, instead of temporary workspace, with the information from the switch. If you
don't want to save the values, click Gancel

Note Cancelling the verify operation discards all the PVCs read from the switch that appear in the list
box and removes the pop-up menu from the screen.
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Step 5 To retrieve the settings from the global database, clidRead DB The Existing PVCs list
is updated to show all PVCs currently configured between the specified endpoints in the global
database.

Verifying VLI Attributes
Step 1 Start VLI Configure.

Step 2 Click on the interface that you want to verify in the Selected Interfaces list.

Step 3 To retrieve configuration values from the switch, click orvédfy button. The configurator
gets the current configuration from the local swiechh-time memory and displays it in the
workgroups summary box.

Caution If a card or port is down, due to a fault or an administrative action, then no workgroups
are displayed. If you save the results of the verify when a card is down, it erases all of the workgroup
attribute values for that interface in the configurator’s temporary workspace and you will have to
reconfigure them. If you accidentally save the results of the ytrég you can either exit from the
configurator without saving or you can wait until the card/port comes up and perform another verify
(If you exit without saving, you lose any other changes you have made during the configuration
session.

Step 4 To store the values from the switch in the configurattemporary workspace, click
on Savefrom the pop-up menu. This replaces any values that were in the temporary
workspace with the information from the switch. (Click@ancelif you dont wish
to store the values.)

Overriding a Configurator Lock

When the configuration databaséoieked the database in read-only modeuYshould not edit
it without investigating the reason for the lock.

A database can become locked for two reasons:
® Someone is editing the database (the most likely cause of a lock).

® The configurator exited ungracefully because of a power failure or a hardware or software
problem.

When you open the database file, one of two messages is shown:

® |fthe database is unlocked, then you are asked which database access mode you want: read/write
or read onlylf you select read/write, then the database is locked to other users and you can make
changes to the database file. If you select read theely it isnt locked and you can only examine
the settings in the file.

® |f someone else is using the database in read/write mode or the configurator has exited ungracefully
then the configurator reports that the database is locked and gives you the cursamamser(If the
configurator has exited, then it gives you the name of user who was running the configurator at the
time.) At this point, you can choose to look at the database in read only mode or you can ovetride the
lock. You should only override the lock if the configurator has exited ungracefully
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Caution If another user is editing the databasendboverride the lock or you will corrupt the
database. Wt until the other user exits and the configurator will automatically remove the lock, or use the
database in read only mode.

There is one lock for the database, regardless of the tool used to access the database (Node
Configure, PVC Configure or VLI Configure). If someone is using the node configurator in
read/write mode, then the database is reported as locked if you try to open the file with the PVC or
VLI Configure.
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